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iSync Plug-in Maker is a developer tool that allows you to build, test, and release device plug-ins. With iSync
Plug-in Maker, you can create plug-ins according to the specific features supported by a device. This includes
the ability to write modem scripts for using the device to connect to the Internet. You can also use the tool
to run a suite of standard automated tests, even if you didn’t use the tool to create the plug-in. The tool
reports error details so you can detect and fix bugs in the plug-in before shipping.

This document describes the iSync Plug-in Maker application and how you use it to develop iSync device
plug-ins for Mac OS X. It provides a comprehensive guide to using the tool through each stage of the process:
editing, testing, and exporting plug-ins.

iSync Plug-in Maker also includes documentation of numerous manual tests that should be run to fully test
your plug-in. The manual tests contain steps that use Apple applications and iSync to modify and sync
records—these steps cannot be automated. The manual tests are not described in this document. Read iSync
Manual Test Suite Guide for information on manual tests.

Note:  The Open Mobile Alliance (OMA) Data Synchronization Working Group is developing specifications
for data synchronization that includes SyncML technology. This document refers to the data synchronization
technology as SyncML.

Who Should Read This Document?

You should read this document if you are a phone manufacturer supplying iSync plug-ins or a third party
that builds iSync plug-ins for Mac OS X. This document assumes you are familiar with handheld device
technologies such as USB, Bluetooth, and SyncML. It assumes you know how syncing works in general, but
not specifically how it works on Mac OS X. You do not need to know how to use the Sync Services framework
in Mac OS X to use iSync Plug-in Maker. However, an overview of this technology is useful.

Organization of This Document

Read this chapter first for an overview of the process involved in creating and testing iSync plug-ins:

 ■ “Overview of Creating Plug-ins” (page 9) describes the process of building and testing iSync plug-ins.

Read these chapters in sequence to learn how to use the iSync Plug-in Maker tool:

 ■ “Editing Plug-ins” (page 13) explains how to configure the settings for a particular device. Configuration
may include writing JavaScript functions as necessary for communicating over USB or Bluetooth using
SyncML. You can also import and edit a modem script.

Who Should Read This Document? 7
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 ■ “Testing Plug-ins” (page 43) explains how to run the automated test scenarios built into iSync Plug-in
Maker. The testing mode helps you QA your plug-in by locating errors in your configuration or device.

 ■ “Exporting Plug-ins” (page 55) explains how to export your plug-in and modem script for shipping
independent of iSync releases.

See Also

Read iSync Manual Test Suite Guide for detailed descriptions of the manual tests that you should run before
shipping your plug-in.

If you need to write JavaScript functions in iSync Plug-in Maker, read this document:

 ■ iSync JavaScript Reference describes a few classes used to write JavaScript functions in iSync Plug-in
Maker.

If you need to learn more about what SyncML commands iSync supports, read these document:

 ■ iSync SyncML Guide and iSync SyncML Reference describes the SyncML commands supported by iSync.

If you need to debug a sync session using Syncrospector, read this document:

 ■ Sync Services Tutorial provides an introduction to testing syncing applications using Syncrospector.

If you need to know more about the schemas used by Apple applications, read this document:

 ■ Apple Applications Schema Reference

For an overview of Sync Services on Mac OS X, read these documents:

 ■ The chapter Sync Services Overview in Sync Services Programming Guide describes the Sync Services
architecture and core classes.

 ■ The chapter Managing Your Sync Session in Sync Services Programming Guide describes the phases of
syncing: negotiating, pushing, mingling, and pulling. Note that the terms used by Sync Services differ
slightly from the terms used by SyncML.

8 See Also
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You use iSync Plug-in Maker to build and test a plug-in, or just use iSync Plug-in Maker to test an existing
plug-in. If you are building a plug-in, you create an iSync Plug-in Maker document and edit settings in it. For
both new and existing plug-ins, you run a set of automated tests. When the plug-in passes all the automated
tests, you export the plug-in to a package that can be loaded by iSync. Then you run a series of manual tests
using Apple applications, the device, and iSync. If errors occur at any time during this process, return to the
edit state to modify the plug-in and then test it again. The workflow for testing syncing between a device
and iSync on a Macintosh computer is depicted in Figure 1-1.

Note:  iSync Plug-in Maker creates plug-ins only for devices that support local SyncML as specified by the
Open Mobile Alliance as OMA DS. See iSync SyncML Reference for more details on SyncML support.

Figure 1-1 Workflow for creating a plug-in

EndStart
Edit Test Export

Run automated 
test scenarios

Click Export5 Quit tool6Click Test2 iSync

4

If errors, modify plug-in

Edit Plug-in 
settings1 3

Run manual 
test scenarios7

6

If errors, modify plug-in
8

iSync Plug-in Maker is a document-based application—each document window represents a separate iSync
Plug-in Maker document, and you can edit multiple documents simultaneously. Create a new plug-in by
launching iSync Plug-in Maker. An Untitled document window appears. Edit and test the plug-in by following
the steps below. When done, save the iSync Plug-in Maker document by choosing Save or Save As from the
File menu. To create an iSync plug-in, export the document choosing the appropriate format.

1. Editing

9
2009-07-30   |   © 2009 Apple Inc. All Rights Reserved.

CHAPTER 1

Overview of Creating Plug-ins



You begin editing by launching the iSync Plug-in Maker tool and clicking the Edit button in the toolbar
shown in Figure 1-2. (The Edit mode is selected by default.) You use the outline view on the left to move
among all the settings you need to configure a device. These device settings are described in detail in
“Editing Plug-ins” (page 13).

Figure 1-2 Editing plug-ins

2. Testing
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You begin testing by clicking the Test button in the toolbar as shown in Figure 1-3. You add your device
and run a number of automated test scenarios. Your device needs to be connected to your computer
to run these tests. The testing phase is covered in “Testing Plug-ins” (page 43).

Figure 1-3 Testing plug-ins

3. Exporting
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Once your plug-in passes all the automated tests, you export it by clicking the Export button in the
toolbar as shown in Figure 1-4 (page 12). How to export a plug-in and package options are covered in
“Exporting Plug-ins.”

Figure 1-4 Exporting plug-ins

4. Manual Testing

Your plug-in is not complete unless it passes manual tests that involve using Apple applications and
iSync to change and sync records on the computer.

This document does not describe manual testing. Read iSync Manual Test Suite Guidefor detailed
descriptions of the manual tests that you should run before shipping your plug-in.
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This chapter describes how to edit and configure a plug-in.

First create a new document by launching iSync Plug-in Maker; an Untitled document window appears as
show in Figure 2-1. If iSync Plug-in Maker is already running, choose New from the File menu. The File menu
contains the typical menu items used to manipulate a document. For example, choose File > Save to save
an iSync Plug-in Maker document.

By default the edit mode is selected. If not, click the Edit button on the toolbar to begin modifying the plug-in.
You can return to the edit mode at any time during the process of developing a plug-in. For example, return
to this mode after discovering bugs while testing.

Edit a plug-in by first selecting a category from the Settings outline view that appears on the left. The pane
on the right displays the settings for the selected category. Fill in the form on the right to configure the group
of settings. The following sections describe these settings in detail.

Figure 2-1 Edit mode

Settings outline view

Toolbar

Settings panes

General Settings

The settings in this category apply to all types of devices.

General Settings 13
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Vendor

The Vendor pane contains settings pertaining to vendor information and versioning, as shown in Figure 2-2.
The tables following the figure describe the Vendor settings and contain examples.

Figure 2-2 Vendor pane

Table 2-1 Vendor > Credits settings

DiscussionProperty

A human-readable name of the company that created this plug-in.Plug-in vendor

A reverse-DNS style identifier for the company that created this plug-in—for example,
com.apple.

Domain name

A URL for the company's support page—for example, http: //support.apple.com.Support URL

Table 2-2 Vendor > Version settings

DiscussionProperty

Specifies the plug-in release version number. For example, this version number may appear
in the Get Info window in the Finder.

Plug-in version

Device

The Device pane contains settings that are specific to the device, as shown in Figure 2-3.

14 General Settings
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Connect a USB device to your computer or turn on a Bluetooth device and click the Get Device Info button
at the bottom of this pane to automatically fill in some fields with information stored on the device. If you
select a Bluetooth device that is not paired, iSync Plug-in Maker pairs the device to access the information.
You may be prompted to enter a passkey on the phone and the computer to complete the paring process.

Typically, the GMM string in the AT Identification pane identifies the model and the GMI string identifies the
manufacturer, but the device can return any string for these values. For example, the GMI string on Motorola
phones might be “Motorola CE, Copyright 2000.“

The tables following the figure describe the Device settings.

Figure 2-3 Device pane

Table 2-3 Device > Device settings

DiscussionProperty

A human-readable name of the manufacturer of this device or class of devices.Manufacturer name

A human-readable name describing the model or models supported by this plug-in.Device model name

General Settings 15
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DiscussionProperty

A reverse-DNS style identifier used by the device manufacturer. Typically, the model
identifier is more precise than the manufacturer name and device model name—it
may provide details such as a firmware revision. The string should contain the device
manufacturer name, model name, and optionally other information following this
format: com.<device manufacturer>.<device model>.<revision number>.

Model identifier

Table 2-4 Device > Communication settings

DiscussionProperty

Specifies how the device communicates to the computer:
 ■ Bluetooth

Device supports syncing over Bluetooth only.

 ■ USB

Device supports syncing over USB only.

 ■ Bluetooth and USB

Device supports syncing over both Bluetooth and USB.

Communication

Table 2-5 Device > AT Identification settings

DiscussionProperty

Identify the device using CGMI and CGMM strings instead of GMI and GMM
strings.

Use CGMI/CGMM
identification

Identifies the device's manufacturer. iSync chooses this plug-in if the GMI and
GMM strings match the values returned by the device.

GMI string

Identifies the device's model. iSync chooses this plug-in if the GMI and GMM
strings match the values returned by the device.

You can optionally specify multiple GMM strings using this format:
[[[[first_string][second_string][third_string]]

For example, a Samsung-X820 plug-in may set this to
[[SGH-X820][SGH-X820E]].

GMM string

Table 2-6 Device > USB Identification settings

DiscussionProperty

The USB device vendor identifier. Used to identify the device before sending GMI/GMM AT
commands to get the specific model.

You can optionally specify multiple vendor identifiers using this format:
[[[[first_vendor][second_vendor][third_vendor]]

Vendor ID

16 General Settings
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DiscussionProperty

The USB device product identifier. Used to identify the device before sending GMI/GMM AT
commands to get the specific model.

You can optionally specify multiple product identifiers using this format:
[[[[first_product][second_product][third_product]]

For example, you may set this to [[0x1234][0x2345][0x3456]].

Product ID

Icon

The Icon pane allows you to set icons that represent the device in the iSync user interface, as shown in Figure
2-4. Drop the image files with the corresponding resolution on the image views shown in Figure 2-4 to replace
the generic device representations. Your icons should have transparent backgroundd and to support HiDPI
screens, be available in all the resolutions that appear on this pane.

Figure 2-4 Icon pane

General Settings 17
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Table 2-7 Icon settings

DiscussionProperty

A 64x64 pixel wide icon used to represent the device in iSync. Change the icon by double-clicking
the icon or dragging an image from a Finder window or the desktop to this box.

The icon should have a transparent background and will be resized (if larger or smaller) to 64x64.

This property is mandatory.

64x64

A 128x128 pixel wide icon used to represent the device in iSync. Change the icon by
double-clicking the icon or dragging an image from a Finder window or the desktop to this
box.

The icon should have a transparent background and will be resized (if larger or smaller) to
128x128 pixels.

This property is mandatory.

128x128

A 512x512 pixel wide icon used to represent the device in iSync. Change the icon by
double-clicking the icon or dragging an image from a Finder window or the desktop to this
box.

The icon should have a transparent background and will be resized (if larger or smaller) to
512x512 pixels.

This property is mandatory.

512x512

Notes

The Notes pane provides a text box for you to insert notes about the plug-in, as shown in Figure 2-5. These
notes are visible only in iSync Plug-in Maker—they are not included when exporting the plug-in.

Figure 2-5 Notes pane
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Connection Settings

The USB and Bluetooth options in this section are appear if you specify that the device supports them in the
Device pane.

USB

The USB pane covers USB-specific connection settings, as shown in Figure 2-6. The tables following the figure
describe the USB settings and discuss options.

Figure 2-6 USB pane

Table 2-8 USB > Phone Identification Channel settings

DiscussionProperty

Specifies the CDC channel used by USB messages.Transport: CDC channel

Specifies that the protocol used to identify the device is "Standard Hayes
AT commands."

Protocol

Specifies a JavaScript function to execute before sending AT commands
to the device. Typically, you use a connection function if the device needs
to be sent specific AT commands before sending the AT identification
commands (AT+GMI/AT+GMM).

Click the arrow to edit the function. See “JavaScript” (page 36) for details.

Execute "On CDC Connection"
JavaScript function

Connection Settings 19
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DiscussionProperty

Specifies a JavaScript function to execute after sending AT commands to
the device. You can use a disconnection function if you need to return a
device to its original state.

Click the arrow to edit the function. See “JavaScript” (page 36) for details.

Execute "On CDC
Disconnection" JavaScript
function

Table 2-9 USB > Sync Channel settings

DiscussionProperty

Specifies the channel used to sync over USB. Options are:
 ■ Use the same CDC channel that is used for identification

 ■ Use specified OBEX class channel

 ■ Use specified CDC channel

Transport

Specifies that the protocol used for syncing over USB is "OBEX with standard
SyncML target UUID."

Protocol

Specifies the time in seconds that iSync waits between sending a message
to the device and receiving a response. If the timeout expires, iSync aborts
all operations and displays an error to the user.

Timeout in seconds

Specifies a JavaScript function to execute before sending an OBEX connect
command to the device. Typically, you use a connection function if you need
to enable SyncML communication with a device.

Click the arrow to edit the function. See “JavaScript” (page 36) for details.

Execute "On OBEX
Connection" JavaScript
function

Specifies a JavaScript function to execute after sending an OBEX disconnect
command to the device. You can use a disconnection function if you need
to return a device to its original state.

Click the arrow to edit the script. See “JavaScript” (page 36) for details.

Execute "On OBEX
Disconnection" JavaScript
function

Bluetooth

The Bluetooth pane covers Bluetooth-specific connection settings, as shown in Figure 2-7. The tables following
the figure describe the Bluetooth settings and discuss options.

20 Connection Settings
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Figure 2-7 Bluetooth pane

Table 2-10 Bluetooth > Sync Channel settings

DiscussionProperty

Specifies the RFCOMM channel used by Bluetooth messages. The options
are:
 ■ Standard SyncML Profile

 ■ Serial Profile

Transport

Specifies that the protocol used for syncing over Bluetooth is "OBEX with
standard SyncML target UUID."

Protocol

Specifies the time in seconds that iSync waits between sending a message
to the device and receiving a response. If the timeout expires, iSync aborts
all operations and displays an error to the user.

Timeout in seconds

Specifies a JavaScript function to execute before sending an OBEX connect
command to the device. Typically, you use a connection function if you need
to enable SyncML communication with a device.

Click the arrow to edit the function. See “JavaScript” (page 36) for details.

Execute "On OBEX
Connection" JavaScript
function

Specifies JavaScript function to execute after sending an OBEX disconnect
command to the device. You can use a disconnection function if you need
to return a device to its original state.

Click the arrow to edit the function. See “JavaScript” (page 36) for details.

Execute "On OBEX
Disconnection" JavaScript
function

Connection Settings 21
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SyncML

This pane covers SyncML-specific settings, as shown in Figure 2-8. The tables following the figure describe
the SyncML settings and discuss options.

Figure 2-8 SyncML pane

Table 2-11 SyncML > General settings

DiscussionProperty

Specifies the version of SyncML supported by the device. See
iSync SyncML Reference for details on SyncML support.

SyncML version

Specifies that the SyncML transport mechanism is "OBEX Client."SyncML transport

Specifies the maximum number of commands allowed per
SyncML message.

Limit the number of sync commands per
message to

The device requires relative rather than absolute URL paths.Device needs relative paths for URLs

Table 2-12 SyncML > SyncML Support settings

DiscussionProperty

Device supports the ability to send and receive objects that exceed the size limit of
a single message by splitting the object into several messages. For example, a contact
with a picture might exceed the size limit of a single message.

Large Object

22 Connection Settings
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DiscussionProperty

Device tells iSync the total number of changes it has before syncing. This allows iSync
to display a more accurate progress indicator—for example, displays a message that
“x of y changes” are received. The information is also sent to the device.

Number of
Changes

If the device supports a Refresh From Server sync, then iSync resets as follows:
 ■ The device removes all its records.

 ■ iSync sends all its records to the device.

During this sync mode, the device only pulls records—it does not send any changes
to iSync.

If the device does not support refresh sync, then iSync resets as follows:
 ■ iSync negotiates a slow sync with the device.

 ■ The device sends all its records to iSync.

 ■ iSync sends deletions for each record it receives.

 ■ iSync sends additions for all its records.

The reset takes much longer when the device does not support refresh sync.

Refresh From
Server

Table 2-13 SyncML > Busy Signaling Support settings

DiscussionProperty

iSync sends Busy Signaling messages to the device when it is busy so
the device does not timeout.

Typically, iSync needs to wait after pulling records from the device
during the mingling phase because other applications may join the
sync session—for example, .Mac might be syncing and have changes
to push to the device.

Device supports receiving Busy
Signaling messages

Device supports only a single Busy Signaling message from iSync. iSync
cannot request the device to wait more than once.

Device can receive only one Busy
Signaling message

iSync sends an empty sync command periodically when it is busy.

Select this option if the device does support Busy Signaling or only
accepts a single Busy Signaling message. Otherwise, the device may
timeout during a sync.

Simulate Busy Signaling with an
empty sync command

The time interval in seconds between the time iSync sends Busy
Signaling messages or empty sync commands to simulate Busy
Signaling.

Busy Signaling interval in seconds

Sync Settings

The Sync Settings category covers settings pertaining to iSync and syncing behavior such as the database,
vCal/vCard support, and iSync user interface settings.

Sync Settings 23
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Read “Supported Properties” (page 31) for how to edit the supported field settings on the Contacts, Events,
and Tasks panes.

General

The General pane covers settings common to all syncing devices as shown in Figure 2-9. The options in this
pane are discussed in the following tables.

Figure 2-9 General pane
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Table 2-14 General > Alarm and Time Zone Support settings

DiscussionProperty

Specifies the date formats supported by the device. The options are:
 ■ Local time

 ■ GMT

For example, if the date is May 5, 2004 10:05:00 AM in iCal, with a GMT+2
system time zone, and the device handles only local time, then iSync sends
20040505T1000500 to the device. If the device handles GMT, then iSync sends
20040505T080500Z to the device. The “Z” in the format indicates GMT.

Device handles dates as

Specifies the alarm types supported by the device. The options are:
 ■ Audio (AALARM)

 ■ Display (DALARM)

Supported alarm types

Table 2-15 General > vCal and vCard settings

DiscussionProperty

Specifies the character set supported by the device in vCal and vCard records. The options
are:
 ■ UTF-7

 ■ UTF-8

 ■ ISO-8859-1

Character set

Specifies the format of property values that are folded on multiple lines. The options are:
 ■ Keep all whitespace characters following CRLF

All the whitespace characters following a CRLF character sequence are part of the
property value even if the property value is encoded in Quoted-Printable. (CRLF
represents a character sequence where CR is Carriage Return and LF is Line Feed.
Quoted-Printable is an encoding used when there are non-ASCII characters in a property
value.)

 ■ Ignore first whitespace character following CRLF except when using Quoted-Printable

The first whitespace following a CRLF character sequence is not part of the property
value and should be ignored except when the property value is encoded in
Quoted-Printable.

 ■ Always ignore first whitespace character following CRLF

The first whitespace following a CRLF sequence is not part of the property value and
must be ignored, even if the property value is encoded in Quoted-Printable.

Folding style

Sync Settings 25
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Table 2-16 General > Device SyncML Databases Settings

DiscussionProperty

iSync needs to know if a device stores tasks and events in separate databases,
so it can properly sync all the relevant databases.

Device uses different
databases for tasks and
events

Select one of these database options:
 ■ No target database names in Server Alert

No target database names should be included in the Server Alert message
sent to the device. (Server Alert is the first SyncML message sent to the
device that begins a sync session.) Passing the database names is optional.

Typically, you select this option if the user can change the database names
on the device.

 ■ Use the following database names

Device requires database names in the Server Alert message. Typically, you
select this option and enter alternative database names if the device uses
different database names than iSync.

Databases Names

Contacts

The Contacts pane covers settings specific to the Contacts database, as shown in Figure 2-10. The options
in the Contacts pane are discussed in the tables following the figure. Read “Supported Properties” (page 31)
for how to edit the Supported Properties section.
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Figure 2-10 Contacts pane

Table 2-17 Contacts > Contact Options settings

DiscussionProperty

Select one of these company name options:
 ■ Device supports contacts with company name only

Device properly displays contacts if they have a company name but
no first and last name.

 ■ The company name is used as the first name if needed

iSync sends the company name as the first name so the contact is
displayed correctly on the device. Select this option if the device
doesn’t properly display contacts that have a company name but no
first and last name.

Company only contacts

Device doesn't use a separate field for the first and last name.First and last name share the
same field on the device
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DiscussionProperty

iSync places the full Street Address in the vCard LABEL property instead
of the ADR property.

Device uses vCard LABEL
property

Events

The Events pane covers settings specific to the Events database, as shown in Figure 2-11. The options in this
pane are discussed in the tables following the figure. Read “Supported Properties” (page 31) for how to
configure supported properties.

Figure 2-11 Events pane

Table 2-18 Events > Recurrence Support settings

DiscussionProperty

Device supports recurrent events as defined by the vCal specification.
If the device doesn’t support the entire specification, click the Configure
button to set the recurrence options, which are shown in Figure 2-12
and explained below.

Device supports vCal recurrences

Options are:
 ■ Until Date and Count

 ■ Until Date Only

 ■ Count Only

Supported recurrence end type
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Table 2-19 Events > All-Day Events Support settings

DiscussionProperty

All-day event format options are:
 ■ OMA Formatting

For example, DTSTART: 20060521T000000 and DTEND: 20060521T240000 are
formatted in OMA.

 ■ From Midnight to Midnight

For example, DTSTART: 20060521T000000 and DTEND: 20060522T000000 are
formatted from midnight to midnight.

 ■ Use CATEGORIES Property

Tags all-day events with a specific property. If you select this format, the property
value used to tag the events can be specified in the Advanced Options > Databases
settings > Events database settings.

 ■ From Midnight to 23:59

For example, dates between DTSTART: 20060521T000000 and DTEND:
20060521T235900.

All-day events
format

If the device supports recurrent events then select the "Device supports vCal recurrences" option in the
Recurrence Support section of this pane. Then click the Configure button to set the recurrence options. A
sheet appears as shown in Figure 2-12. Use this sheet to configure the details of what recurrence rules the
device supports.

The table and layout on the recurrence sheet is similar to the Advanced Options pane. Select a row in the
table to display a description of the option in the view at the bottom of this sheet. If a value is one of several
options, select the appropriate option from the corresponding pop-up menu. Otherwise, double-click in a
cell in the Value column and type in the value.
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Figure 2-12 Recurrence sheet

Tasks

The Tasks pane covers settings specific to the Tasks database, as shown in Figure 2-13. The options in these
panes are discussed in the tables following the figure. Read “Supported Properties” (page 31) for how to
configure supported properties.
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Figure 2-13 Tasks pane

Table 2-20 Tasks > Task Options Settings

DiscussionProperty

Device supports tasks in addition to events in the Calendars schema. Tasks are the
same as To Do items in vCal.

Device supports tasks

Supported Properties

Each of the schema panes—the Contacts, Events, and Tasks panes—contains a Supported Properties section
at the bottom of the pane that allows you to turn on or off properties of records that you want to sync. You
can also configure the length of string values and configure other property-specific options. Some of the
options pertain to reformatting records that are pushed to the device. In summary, you can use the Supported
Properties section to specify a subset of the standard Apple schemas that the device supports. Only the
properties and values you specify in the Supported Properties section are synced to the device.

The Supported Properties section contains a table like the one shown in Figure 2-13. The Property Name
column contains the names of the properties of each corresponding entity defined in an Apple schema. For
example, “First name” and “Last name” are properties of the Contact entity in the Contacts schema. When
you create a new iSync Plug-in Maker document, all of the properties are enabled representing a full-featured
device. Deselect the properties you want to disable. Some properties are mandatory and therefore, cannot
be disabled.

Some properties are relationships to other entities. For example, the “Street addresses” and “Related name”
properties are to-many relationships from the Contact entity to the “Street Address” and “Related Name”
entities respectively. Click the triangle to the left of an option to view the properties of a relationship. For
example, click the “Street addresses” property in the Contacts pane to reveal and configure the City, State,
and “Postal code” properties as shown in Figure 2-14.
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Note:  iSync maps the Apple schema entities to the corresponding vCard and vCal properties. The tooltip
for a property name in the Supported Properties table displays the corresponding vCard or vCal property.
There is not always a one-to-one mapping between an Apple schema entity and a vCard and vCal property.

Figure 2-14 Street addresses properties

The Type column in the Supported Properties table displays the property type for each attribute—relationships
do not have an attribute type. For example, an attribute type might be String, Date, or Image. If the type is
Label, the attribute is one of several values, as in an Address Book label, such as “work”, “home”, or “other.“

The Max Length column displays the maximum length of a string field—specifically the maximum number
of characters in a String value. Double-click the cell in this column to change the maximum number of
characters supported by the device. iSync reformats records pushed to the device to fit in the specified string
size.

Click the More button in the Options column to configure more details about a field. For example, click the
More button for an attribute of type Label to select the possible labels the device supports. A More button
is disabled if an attribute has no options or is not enabled. Relationships do not have a More button. The
following sections describe the type-specific sheets that appear when you click the More button.

String Types

Figure 2-15 shows more details about a String attribute type. This sheet allows you to control the format of
string attributes that are pushed to a device.

Select the “Allow all characters” option if there are no restrictions on the content of a string attribute.

Select “Remove forbidden characters” if you want selected characters removed from a string pushed to the
device. If you select this option, enter the forbidden characters, without any separators, in the adjacent text
field. For example, enter ;., to remove semicolons, periods, and commas from the string.

Select “Accept only allowed characters” if you want to limit the characters in a string to those entered in the
adjacent text field.

Select “Use default value for empty attribute” if you want to specify an alternate string for an empty attribute.
If this option is selected, enter the alternate string in the adjacent text field.

Click Done to apply your changes or Cancel to revert to the previous settings.
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Figure 2-15 String More button sheet

Label Types

Figure 2-16 shows the labels of an attribute of type Label for the “Email address type” attribute of an Email
Address entity. The table at the top of this sheet contains the supported Mac labels and corresponding vCard
values.

You use this sheet to specify the supported labels and may limit the number of email addresses or phone
numbers allowed on the device. Click a checkbox in the “Sync this type” column to disable or enable a label
displayed in the “Mac value” column. Only records with enabled labels are synced to the device.

You can also use this sheet to change the mapping of Mac labels to vCard types—for example, vCard phone
types such as HOME, WORK, CELL, and FAX. Change a mapping by double-clicking a cell in the “vCard value”
column and typing in a vCard type. You can leave a vCard value blank if the device doesn’t support the Mac
value and you want to sync the record without syncing the vCard type.

You can map multiple labels to a single vCard type as shown in Figure 2-16 where both the work and other
labels are mapped to the WORK vCard type. When multiple labels are mapped to the same type, the order of
the rows in this sheet determines the value that is used when transforming device records to computer
records. For example, if a phone number is created on the device with a vCard value of WORK, it will be mapped
to the computer label work because it appears before other in the table on the Label More button sheet.
Drag and drop the rows in this table to change the order.

Use the controls below the table to limit the number of records in the corresponding to-many relationship—for
example, limit the number of targets of the to-many relationships from Contact to Phone Number or Contact
to Email Address. In other words, you can limit the number of phone numbers or email addresses per contact
that are synced to the device. Select the Unlimited option if the device as no limits. Select the “Limit to”
option and enter the number of records the device supports for the corresponding to-many relationship.
Select the “One per type” option if the device only supports one record per vCard type.

Click Done to apply your changes or Cancel to revert to the previous settings.
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Figure 2-16 Label More button sheet

Enumerated Types

Figure 2-17 shows an Enumerated attribute type details sheet for the Tasks database Status field. The table
at the top of this sheet behaves similar to the table at the top of the Label More button sheet, except that
you can not disable Mac values.

Change a mapping from a Mac value to a vCal value by double-clicking a cell in the “vCard value” column
and typing in a vCard value. You can leave a vCard value blank if the device doesn’t support the Mac value
and you want to sync the record without syncing the vCard value. You can map multiple Mac values to the
same vCal value. Drag and drop a row to change the search order for a Mac value when transforming vCal
records to computer records.

Click Done to apply your changes or Cancel to revert to the previous settings.

Figure 2-17 Enumerated More button sheet
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iSync UI

The iSync UI pane, shown in Figure 2-18, allow you to configure the user interface in iSync based on what
the device supports. The user interface features are organized by schema. Currently, there are only Contacts
and Events user interface options. Each of these settings corresponds to a control in the iSync user interface.

Figure 2-18 iSync UI pane

Use these settings to set whether an option is visible to the user in iSync and set its default value. All of the
Contacts and Events controls on this pane correspond to a control on the More Options pane in iSync. A
preview of all the options is provided at the bottom of this pane so you can see what the iSync user interface
looks like. If an option is not visible, then iSync uses the default value for all records sent to the device. If an
option is visible, the associated control displays the default value in the More Options pane in iSync.

Use the settings on this pane cautiously. The iSync user experience should not change too much from device
to device. New plug-ins should show the same user interface controls as those shipped by Apple. Therefore,
seriously consider removing or adding controls to iSync before doing so. If you remove a control, carefully
choose a default value because the user can not change it after the plug-in ships.

The options in the Events section, described in Table 2-22, let you configure how events are synced to a
device. The checkbox and pop-up menu settings allow you to filter events by a time interval. For example,
if the device has limited capacity, you can filter the number of events synced to the device by a time interval.
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Set the default value of the "Don't synchronize events prior to" and the "Don't synchronize events after"
checkboxes to On. Also, deselect Visible in iSync (located at the right side of the pane) for these options so
the user can’t sync all events. Select the appropriate default interval values for the corresponding pop-up
menus that range from one day to one month. Optionally, select Visible in iSync for the pop-up menu options
if the user is allowed to change these settings.

Table 2-21 iSync UI > Contacts settings

DiscussionProperty

If the device does not support contacts without a phone number, you might
set the default value to On and deselect the Visible in iSync checkbox. If the
device does not display contacts without phone numbers, then you might set
the default value to Off and deselect the Visible in iSync checkbox. This way,
users are not bothered with options that are not supported by the device

Sync only contacts with
phone number

Table 2-22 iSync UI > Events Settings

DiscussionProperty

If you want to allow the number of events synced to a device to be
filtered by a time interval, then set the default value for this option to
On and select the Visible in iSync option.

"Don't synchronize events prior
to" checkbox

Choose the default value for the start of the time interval used to filter
events. Select Visible in iSync if the user is allowed to change the start
date.

"Don't synchronize events prior
to" pop-up menu

If you want to allow the number of events synced to a device to be
filtered by a time interval, then set the default value for this option to
On and select the Visible in iSync option.

"Don't synchronize events after"
checkbox

Choose the default value for the end of the time interval used to filter
events. Select Visible in iSync if the user is allowed to change the end
date.

"Don't synchronize events after"
pop-up menu

If the device does not display all-day events nicely, then set the default
value for this option to Off. For example, some devices may display an
all-day event as an event from 0:00 to 23:59 that may obscure other
events on the same day.

Note that iSync always allows users to sync all-day events to a device.

Synchronize all-day events

JavaScript

Click JavaScript in the outline view to optionally edit any of the JavaScript functions used to communicate
with the device. The JavaScript pane is shown in Figure 2-19. These are the same JavaScript functions that
you can access from the Connection > USB and Connection > Bluetooth panes. The table in the upper-left
corner of the JavaScript pane contains groups of JavaScript functions. Use this table to navigate to the
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JavaScript function you want to edit. For example, reveal the contents of “USB functions” and select On OBEX
Connection. The Run column in this table displays Yes if the JavaScript function is enabled, and No if it is
disabled.

Figure 2-19 JavaScript pane

The Description table in the upper-right corner of the JavaScript pane displays a brief description of the
JavaScript function. The description states what the JavaScript function does and when it is executed.

The text box at the bottom of the JavaScript pane displays the selected JavaScript function. Use this text box
to edit the JavaScript function. The behavior of this editor is similar to that of the TextEdit application. Just
click anywhere in the text box to begin typing. Read iSync JavaScript Reference for how to write iSync JavaScript
functions.

Click the Revert to Default button at the bottom of the pane if you want to revert to the system default
settings—this action deletes your changes. Click the Check Syntax button to correct any syntactical errors
in your JavaScript code.
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Modem Script

A modem script is used to communicate with and control the device as a modem for the purpose of connecting
to the Internet. Modem scripts are written using the Communication Command Language (CCL) scripting
language. Use the Modem Script pane shown in Figure 2-20 to configure modem options and write a CCL
script. Table 2-23 and Table 2-24 describe the various settings on this pane to configure the connection and
carrier. Table 2-25 describes how to import and edit a modem script.

Read CCL Modem Scripting Guide for details on CCL.

Figure 2-20 Modem Script pane

Table 2-23 Modem Script > Connection settings

DescriptionProperty

Choose either Dialup or GPRS from the “Connection type” pop-up menu.
If you choose Dialup, the user supplies a phone number to the script. If
you choose GPRS, the user supplies an APN and CID to the script. If this
information is known in advance, a GPRS modem script bundle can store
a default APN and CID so the user doesn't have to provide them.

Connection type
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DescriptionProperty

Choose the maximum number of context identifiers (CIDs) supported by
the device from the “Maximum supported CIDs” pop-up menu.

Maximum supported CIDs

Select this option if the device supports the +CGDCONT? AT command
for querying CID mappings.

Supports +CGDCONT? for
querying current CID mappings

Select this option if the +CGDCONT= AT command doesn’t change stored
CID mappings.

Some GPRS devices overwrite internal CID mappings when a GPRS
connection is configured. The use of arbitrary CIDs with such devices may
overwrite important APN information stored in the device.

AT+CGDCONT= doesn’t change
stored CID mappings

Select this option if the device allows GPRS connections to be initiated
using the escape sequence *99, followed by a CID identifier or # for the
default CID configuration.

Supports ‘Dial Mode’ initiation
(*99)

Select this option if the device allows GPRS connections to be initiated
using the +CGDATA AT command.

Supports ‘Data Mode’ initiation
(+CGDATA)

Table 2-24 Modem Script > Carrier Specific (Optional)

DescriptionProperty

If the service plan is known and APN information for Internet connectivity is stored in the
device, accessible by a particular CID, specify that CID here. This setting is also useful for
devices that overwrite stored CID information. In this case, a CID that is likely to be "empty"
can be specified to prevent overwriting APN information in the device. The preferred CID
is the default CID in the user interface for this script, although the user may change it.

Preferred CID

If the service plan is known in advance, enter the APN string used by a computer connecting
to the Internet through the modem device.

Preferred APN

Table 2-25 Modem Script > CCL Script

DescriptionProperty

Select Automatic or a connection speed from the Connection Speed pop-up menu.
This string may be used by the script to control the speed of the connection.

Connection Speed

Enter an AT command to initialize the device.Init AT String

Click “Import CCL script” to import and edit a CCL script in the text view below.
Changes you make in the text view are saved with the plug-in, not the imported
file. See CCL Modem Scripting Guide for details on writing this script.

Import CCL script

Enter the values of the variables used by the CCL script into these text fields. Look
for comments at the top of the script for which variables it uses, if any. How these
variables are used depends of the script. Using the variables is optional.

Reserved for script use
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Advanced Options

The Advanced Options pane, shown in Figure 2-21, contains additional options that are infrequently used.
Use this pane to configure device-specific options. For example, use this pane to specify how a record is
reformatted from an Apple record to a vCard or vCal property field used by the device. Use this pane if your
device uses different vCard or vCal properties than the defaults.

The options in this pane are displayed in a table and organized in a way that is similar to key-value pairs in
a property list. The property/option is listed in the Options column and the value is listed in the Value column.
Use the Filter pop-up menu located above the table to filter the options by category. Use the search field to
the right of the Filter menu to search for a specific option by name.

Figure 2-21 Advanced Options pane

Select a row in the table to display a description of the option in the view at the bottom of this pane, as
shown in Figure 2-22.
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Figure 2-22 Advanced option descriptions

If a value is one of several options, select the appropriate option from the corresponding pop-up menu.
Otherwise, double-click in a cell in the Value column and type in the value.

Some Value cells contain an Edit button. Click the Edit button to specify key-value pairs that map iSync
property names to device property names. A sheet appears as shown in Figure 2-23. Click the plus button
in the lower-left corner of sheet to add a key-value pair. Click in the “iSync property” column to enter the
iSync property name that you are mapping. Click in the “Phone mapped property” column to enter the
corresponding device property name.
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Figure 2-23 Edit button sheet
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Click the Test button on the toolbar to begin testing the plug-in using the automated tests scenarios provided
by iSync Plug-in Maker.

If this is the first time you are using the device with the computer, you need to hook up the device to the
computer for USB devices, or pair the device with the computer for Bluetooth devices now. Follow the
instructions in “Adding Devices” to add a device to iSync Plug-in Maker before running the tests.

Once a device is added to iSync Plug-in Maker, the window changes to the testing mode, as shown in Figure
3-1. The column on the left of the window displays the added devices. The column on the right displays an
outline view of the test scenarios. Note that you can return to the testing mode at any time during the process
of developing your plug-in. For example, return to this mode after modifying a plug-in and before exporting.

Figure 3-1 Test mode

Click to remove a device Status
Click to add a device

Tests

Click to reveal
individual tests

Select to mark
groups or 
individual tests

Save results to a file
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Important:  If the plug-in contains a modem script, you should also test the modem script by connecting to
the Internet using the device. Run this test using different carriers. This test is not automated.

Adding Devices

The first time you test a phone, you need to add the device to iSync Plug-in Maker as follows:

1. Click the plus button in the lower-left corner below the list of devices.

A sheet appears with a list of devices that iSync Plug-in Maker detects, as show in Figure 3-2.

Figure 3-2 Adding a device

2. Select the device from the list and click the Select button.

The device should appear selected in the Devices column.

Note:  iSync Plug-in Maker pairs the device with the computer before adding it to the list. Therefore, the first
time you communicate with a Bluetooth device, a panel may appear prompting for a passkey. To add a
Bluetooth device, enter a passkey on the device when prompted and enter the same passkey in the panel
that appears on your computer.

Testing

After adding the device, select it in the Devices list and select the scenario you want to run from the Tests
outline view. Click a triangle to reveal the contents and select a test or groups of tests you want to run. For
example, select Scenarios > Level 0 > Contacts to run the first-level tests using the Contacts database.

Follow these steps to run the tests:

1. Select the test or tests from the Tests outline view.

2. Click the Start button in the toolbar.
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A progress indicator appears below the Tests outline view as show in Figure 3-3. The status message
below the progress indicator displays the test number and the total number of tests that will be run. It
also displays the name of the test that is running.

When the tests are done, the status message displays the number of bounces and failures, and the total
duration of the tests.

Figure 3-3 Running tests

State of a test

Test in progress

Indicates failure

Test details

Progress of running tests

Total duration of tests

Connected devices

3. If you want to temporarily stop a running test, click the Pause button.

4. Click the Resume button to continue a test that is paused.

5. If you want to stop all the selected tests from running, click the Stop button.

The Tests outline view also displays the status of individual tests in the State column. When a test is executing
tests the word "Running" appears in the column. Other symbols may appear in this column indicating the
success or failure of individual, and groups of tests as shown in Figure 3-4. For example, a green checkmark
indicates success and a red exclamation mark indicates failure. Hold the mouse over a state icon to display
a tooltip with more details. For example, a tooltip might explain where a test failed. Refer to Table 3-1 for
the meaning of the icons that appear in this column.
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Color is also used throughout the iSync Plug-in Maker user interface to indicate state. In general, green
indicates success, yellow indicates warning, and red indicates failure. In some cases, black and white icons
indicate a stall or old state. For example, if a test is successful and you modify the plug-in, the icon changes
from green to black and white to indicate that the test needs to be rerun with the updated plug-in.

If you want to show just the errors in the Tests outline view, select the “Show only errors” option at the
bottom of the outline view. Click the “Export results” button if you want to save the test results to a file.

Read “Troubleshooting” (page 47) for information on debugging failed tests.

Warning: The tests performed by iSync Plug-in Maker are automated. You invalidate test results if you
manually modify records on the device while running a test.

Figure 3-4 Example of test states

Table 3-1 Test states

DescriptionText/Icon

The test is in progress.Running
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DescriptionText/Icon

The test is successful.

The test is successful—ran without any errors—but the device requested a slow sync during
one of the sync sessions. Read “Troubleshooting” for how to diagnose problems.

The test completed but with some errors—for example, records were bounced, forgotten, or
refused. Read “Troubleshooting” for how to diagnose problems.

The test failed. Read “Troubleshooting” for how to diagnose problems.

Same as except the test was run using an earlier version of the iSync Plug-in Maker
document. Rerun this test before exporting the plug-in.

Same as except the test was run using an earlier version of the iSync Plug-in Maker
document. Rerun this test before exporting the plug-in.

Same as except the test was run using an earlier version of the iSync Plug-in Maker
document. Rerun this test before exporting the plug-in.

Same as except the test was run using an earlier version of the iSync Plug-in Maker
document. Rerun this test before exporting the plug-in.

Troubleshooting

iSync Plug-in Maker provides extensive debugging support when tests fail. You can see the details of each
test run by examining individual sync sessions or by displaying a log of every message sent to and from the
device.

Select a test and click the Details button in the toolbar to open the Details window (or click an icon in the
State column). The Details window contains a toolbar allowing you to switch between the History and Logs
panes. Which pane to most useful depends on the state of the test. If the state of a test is pass or bounce,
then use the History pane to help locate the problem. If the state of the test is failed, then use the Logs pane
to display the sequence of messages.

History Pane

Click the History button in the toolbar of the Details window to display information about each sync session
that was created when running the tests, as shown in Figure 3-5.
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Figure 3-5 History pane

Sessions created during test

Contents of device
after sync session

Contents of record

Select record formats

Sync Session Table

Each test may involve several sync sessions, which are listed in a table located in the upper left of the History
pane. The Sync Session column contains the names of the sync sessions. Typically, the first sync session
deletes all records on the device before sending modifications. The following sessions add, modify, or delete
records, and the last session verifies all records on the device. The last sync session is called Verification and
appears at the end of the table.

Note:  iSync Plug-in Maker deletes all records on a device so the device is in a clean and known state before
running a test. However, these deletes do not appear in the History or Logs panes so you can focus on the
modifications and transactions that pertain to the test, not the setup.

The State column displays an icon that indicates a problem during the sync session. It is considered a problem
if a device requests a slow sync because it is much slower than a fast sync. The value in the State column is
blank if no problems occur. For example, a warning icon is displayed if the sync is refused, forgotten, or
bounced, and a slow icon is displayed if the device slow synced. Table 3-2 describes the different states that
might appear in this column.

Select a session in the sync session table to see the modifications pushed to the device from the beginning
of the test to the end of the selected session. The modifications are displayed in a table located in the upper
right of the History pane. Select the “Show only modifications of the selected session” option if you want to
see just the modifications during the selected session.
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Table 3-2 Sync session states

DescriptionIcon

The sync session finished without errors but the device requested a slow sync. Display the tooltip
for more details. Read “Logs Pane” for how to diagnose this problem—specifically, examine the
sequence of SyncML messages.

The sync session finished with some errors—for example, records were bounced, forgotten, or
refused. Display the tooltip for more details. Read “Logs Pane” for how to diagnose this problem.

The device requested all the records for no reason or cancelled the sync session. This typically
indicates that records on the device are corrupted. Read “Logs Pane” for how to diagnose this
problem.

Record Table

The table on the right displays all the records in the selected sync session. The Record column in this table
displays the record identifier—for example, the schema name followed by a colon and a unique number for
a record.

The Direction column indicates whether the modification was pushed or pulled. Table 3-3 describes the
meaning of the different icons that might appear in this column.

Table 3-3 Record Directions

DescriptionIcon

Record was pushed to the device.

Record was pulled from the device.

The Action column indicates the type of change—for example, Add, Modify, or Delete.

The State column displays the state of the modification on the device—for example, Refused, Forgotten,
Bounced, or Resent, as described in Table 3-4. The value in the State column is blank if the modification is
accepted.

Table 3-4 Record states

DescriptionText

A record modification is refused if the device refuses it through an appropriate SyncML status.
This indicates that the record cannot be stored on the device—for example, it might contain
unsupported properties. Change the sync settings to avoid generating unsupported records.

Refused

A record modification is forgotten if the device does not acknowledge it. This usually indicates
that the device cannot handle a record and should have refused it.

Forgotten
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DescriptionText

A record is bounced if a modification sent to the device alters the date on the computer. This
is an error because records should not be modified by the device while running the automated
tests.

Typically, this happens if iSync sends a modification to the device with a string property value
that exceeds the limits of the device. Consequently, the device truncates the string when
storing the record. On a subsequent sync, the truncated version of the record is sent to iSync.
Change the sync settings so that iSync reformats records appropriately.

Bounced

A record is resent if iSync pulls a record from the device that it doesn’t expect. Typically, this
occurs when you manually modify a record on the device while running a test.

Resent

Record Details

When you select a record in the record table, the details are displayed in the pane below. Use the segmented
control below the tables to see the record details as either a parsed Sync Services change object (displayed
as a key-value dictionary), a vCard/vCal object, or a hexadecimal representation.

For example, Figure 3-6 shows two records that were bounced. If you select a bounced record, the record
details show the contents of the record on the device as compared with the contents on the computer.

Figure 3-6 Bounced record

Color is used in the Parsed record view to indicate the type of action. For example, Figure 3-7 shows a modified
record where blue text is used to indicate the fields that changed. Table 3-5 describes the meaning of the
different colors used in the History pane.
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Figure 3-7 Modified record

Table 3-5 Colored records and fields

DescriptionColor

Indicates properties of a record that changedBlue

Indicates a bounced recordRed

Indicates a deleted recordGrey

Logs Pane

Click the Logs button in the toolbar in the Details window to display every message sent to and from the
device, as shown in Figure 3-8. Use the Filters checkboxes on the left to selectively turn on/off different types
of messages. The types of messages are SyncML, WBXML, Transport, and JavaScript messages, where Transport
includes both USB and Bluetooth messages.

A table appears on the right side of the Logs pane listing every message. The columns in this table display
the time the message was sent, the domain or type of message, and part of the message content. Select a
message in the table to see the complete message content displayed in the lower pane.

Click the “Export filtered logs” button at the bottom of the pane to save the selected messages to a file. For
example, to save SyncML messages to a file, select only SyncML in the Filters pane, and click the “Export
filtered logs” button.
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Figure 3-8 Logs pane

Select options to
filter message type 

List of messages

Message details

Setting Preferences

There are several application preferences you can set to change the behavior of the testing phase. Choose
iSync Plug-in Maker > Preferences to open the Preferences window as shown in Figure 3-9.

Select "Pause tests on failure" if you want iSync Plug-in Maker to automatically pause when an error occurs.
For example, choose this option if you need to reboot a device when an error occurs that corrupted the data
on that device. After a test is paused, click the Resume button in the toolbar to continue running the test.

Select "Add a delay of" if you want to pause for a period of time between sync sessions. For example, if you
want to pause for 10 seconds after every sync session, select "Add a delay of", enter 10 in the seconds text
field, and enter 1 in the synchronizations text field.

Select the “Uncheck tests when they have been successfully passed” if you want to incrementally test the
plug-in; otherwise, you need to deselect successful tests before selecting and running the next set of tests.
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Figure 3-9 Testing preferences
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When you are ready to export your plug-in or modem script, click the Export button in the toolbar. An alert
panel appears asking if you have tested the plug-in. Click Yes if you completed the testing phase or Cancel
if you want to continue testing the plug-in.

If you click Yes, a sheet appears allowing you to enter a filename and select an export format from a pop-up
menu, as shown in Figure 4-1. Enter the filename, choose a format, and click Export.

Figure 4-1 Exporting sheet

Which format you choose depends on how you want to ship your plug-in and if you want to export the
modem script separately. For example, if you want to ship the plug-in as a downloadable package, you might
choose "Disk image with installer." If the plug-in is part of another product, then you might choose "iSync
plug-in" and include the file in the product package. If you want to just export the modem script choose
“Modem Script bundle.“ The possible export formats are described in Table 4-1.

Table 4-1 Export formats

DescriptionFormat

Exports the plug-in in a bundle format that can be loaded by iSync. This bundle
includes the iSync plug-in only, not the modem script bundle.

For example, choose this format if you want to run some manual tests on your local
computer. See iSync Manual Test Suite Guide for manual tests that you should run
before shipping your plug-in.

iSync looks in ~/Library/PhonePlugins and then /Library/PhonePlugins for
phone plug-in files. Move your phone plug-in file to one of these folders. Create the
folder if it doesn’t exist.

iSync plug-in
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DescriptionFormat

Exports the modem script as a bundle independent of the iSync plug-in. Choose this
option if you are just adding CCL support for a device.

Modem Script
bundle

Exports the plug-in as an installer package. Choose this format if you are releasing
the plug-in separately. For example, choose this format if you make the plug-in
available on a CD or DVD. Select the appropriate options below the “Export format”
menu to include just the iSync plug-in, just the modem script, or both in the installer
package.

Installer package

Exports the plug-in as an installer in a convenient disk image that is ready for release.
For example, choose this option if you want to make the plug-in downloadable. Select
the appropriate options below the “Export format” menu to include just the iSync
plug-in, just the modem script, or both in the disk image.

Disk image with
installer
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This table describes the changes to iSync Plug-in Maker User Guide.

NotesDate

Added information on supporting multiple devices with a single plug-in.2009-07-30

New document that explains how to use iSync Plug-in Maker to create and test
iSync phone plug-ins.

2007-07-10
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